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1 Introduction

1.1 Welcome to TitrIC

Introduction

TitrIC

TitrIC provides fully automatic water analysis. In a single run, all necessary
sample preparation steps are carried out and the desired titrimetric and ion
chromatographic results are determined.

All ion components are thus determined in a secure, rapid and reproducible
manner. The results are outputted in a joint report and stored in the inte-
grated database.

Structure

The TitrIC user interface is subdivided into two main views:

￭ Workplace
Here the sample table is compiled and the run is started.

￭ Database
Here the determinations are saved; they can be displayed, administered,
reprocessed and printed out.

Mode of operation

TitrIC controls tiamo and MagIC Net simultaneously.
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In the sample table of TitrIC, definition is made as to with which tiamo
method and with which MagIC Net method the various samples will be
measured. At the start of a determination, TitrIC forwards all relevant infor-
mation on to tiamo and MagIC Net. There the respective methods are
processed, after their end the desired results are transmitted back to
TitrIC. TitrIC compiles a joint report and stores the data in its database.

Only one software - TitrIC - needs to be started, all other programs will be
automatically started as well and also automatically closed again when
TitrIC is exited.

1.2 Online Help

Introduction

Calling up the Help

TitrIC has an extensive and detailed Online Help that can be requested in
two ways:

￭ General request

With the menu item Help ▶ TitrIC Help, or the symbol  the Online
Help with the topicWelcome to TitrIC opens. From there you can jump
via Contents, Index, Search or personal Favorites to the desired topic.

￭ Context-sensitive request
With the function key [F1] on the keyboard you can jump directly to the
topic which will show information on the active element in TitrIC (dialog
window, tab).

Symbols and conventions

The following symbols and styles are used in this documentation:

Database Link to other Help topics in which information is shown
for the marked term.

Method Dialog text

Designation for names of parameters, menu items,
tabs and dialog windows in the software.

100 Designation for parameter values in input fields.

File ▶ New Menu or menu item; Path needed to reach a certain
point in the program.

[Continue] Button

Instruction step

Carry out these steps in the sequence shown.
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Warning

This symbol draws attention to a possible life hazard
or risk of injury.

Warning

This symbol draws attention to a possible hazard due
to electrical current.

Warning

This symbol draws attention to a possible hazard due
to heat or hot instrument parts.

Warning

This symbol draws attention to a possible biological
hazard.

Caution

This symbol draws attention to a possible damage of
instruments or instrument parts.

Note

This symbol marks additional information and tips.

1.3 What is new about TitrIC 2.0?

Introduction

New software

￭ Titrators are controlled with tiamo 1.3, older tiamo versions are not
supported.

￭ Ion chromatography instruments are controlled with MagIC Net 1.1,
older MagIC Net versions are not supported. The change from IC Net to
MagIC Net offers improved integration of ion chromatography in the
overall solution TitrIC and enhanced process stability.
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2 Workplace

Definiton

The term Workplace is used in TitrIC to designate the program part in
which the sequence of determinations is controlled and the sample data is
managed.

2.1 Workplace - Desktop

Program part: Workplace

Workplace symbol

Clicking on the workplace symbol in the vertical bar on the left opens the
program part Workplace while, at the same time, the workplace symbol is
shown in color.

Elements

The desktop of the program part Workplace comprises the following ele-
ments:

￭ Menu bar
￭ Toolbar
￭ Sequence control
￭ Sample table

2.2 Menu bar

2.2.1 Workplace - Main menu
Program part: Workplace

The menu bar in the program part Workplace contains the following main
menu items:

￭ File
Create new sample table, open and save sample table.

￭ Sample table
Edit sample table.

￭ View
Show tiamo or MagIC Net.
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￭ Settings
Edit settings for tiamo, MagIC Net, TitrIC and the Reprocessing.

￭ Help
Open Help, show program info.

2.2.2 Menu File
Menu item: Workplace ▶ File

New sample table Create new empty sample table.

Open sample table Open sample table and load it in the workplace.

Save sample table

as… Save the sample table under a new name.

Exit End program.

2.2.3 Menu Sample table
Menu item: Workplace ▶ Sample table

Insert new line... Open the Edit line dialog for editing the sample data and for inserting new lines
after the selected line in the sample table (see Chapter 2.5.2, page 9).

Edit line... Open the dialog Edit line for the selected line of the sample table (see Chapter
2.5.2, page 9).

Delete line Delete the selected line from the sample table.

Reset sample table Reset all of the lines of the sample table to prepared status, i.e. they can be carried
out again.

Not active when the workplace is in BUSY status.

Remove marking Remove marking of selected line(s) from the sample table.

Update methods Update selection of methods from tiamo and MagIC Net which are available for
the editing of sample data (see Chapter 2.5.2, page 9).

Copy Copy selected line.

Cut Cut selected line.

Insert Paste copied line ahead of the selected line. If no line is selected, then the copied
line will be pasted at the end of the sample table.
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2.2.4 Menu View
Menu item: Workplace / Database ▶ View

Show tiamo Show tiamo window.

Show MagIC Net Show MagIC Net window.

2.2.5 Menu Settings
Menu item: Workplace / Database ▶ Settings

Settings tiamo Open dialog window with the settings for tiamo (see Chapter 4.1, page 28).

Settings MagIC Net Open dialog window with the settings for MagIC Net (see Chapter 4.2, page
29).

Settings TitrIC Open dialog window with the settings for TitrIC Net (see Chapter 4.3, page
30).

Settings  Reprocess-

ing
Open dialog window with the settings for reprocessing (see Chapter 4.4, page
31).

2.2.6 Menu Help
Menu item: Workplace / Database ▶ Help

Info Display information about the program and the installation.

TitrIC Help Open TitrIC Help.

2.3 Toolbar

Program part: Workplace

All of the menu items in the Sample table menu can be accessed directly
via symbols in the toolbar.
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2.4 Sequence control

Program part: Workplace

The sample table is started, interrupted or stopped in the sequence control.

Operating elements

Start determination

Start of the first determination in the sample table that has prepared status.
The button switches to [STOP] as soon as a determination is running.

Stop determination

Immediate stop of the determination of a sample table that is currently run-
ning. The button switches to [START] as soon as the determination is
completed.

Interrupt tiamo determination

This button is used to interrupt the ongoing tiamo determination. The button
is enabled as soon as a determination is running. If the stop can be triggered,
then it will be yellow, otherwise gray. When [Pause] is pressed, this button
will be replaced in the display by [Cont].

Resume tiamo determination

Start interrupted tiamo determination. The button is only present in the sta-
tus PAUSE (tiamo determination interrupted). Pressing [Cont] will cause
this button to be replaced again in the display by [Pause].

Status display

Status

Displays the status of the workplace and the selected determination.

Selection READY | BUSY | PAUSE | ERROR

READY
Ready for the start of a determination.
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BUSY
Determination running.

PAUSE
tiamo determination interrupted.

ERROR
Error.

2.5 Sample table

2.5.1 Properties sample table
Program part: Workplace

The sample data and the status of a determination are displayed in tabular
form in the sample table.

Each line corresponds to a determination.

The table cannot be edited or sorted directly. Lines which are selected by
the user are marked with green.

Sample data

For the meaning of the columns please refer to (see Chapter 2.5.2, page
9).

Status

The status of a determination is described by the following columns:

Status

Indicates the status of the determination, dependent upon which the sample
table line of the determination will be marked with color.

Selection prepared | running | finished | canceled
Default value prepared

prepared
The determination can be started. The line is light gray.

running
The determination is running, the sample data is blocked for editing. The
line is dark gray.

finished
The determination is processed. The line is gray.

canceled
The determination was canceled. The line is orange.

tiamo finished

on | off (Default value: off)

Indicates whether the tiamo method has finished.
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MagIC Net finished

on | off (Default value: off)

Indicates whether the MagIC Net method has finished.

2.5.2 Edit sample data
Menu item: Workplace ▶ Sample table ▶ Insert new line / Edit line

The dialog can also be opened with a double-click on the sample table line.

tiamo method

Selection of the tiamo method with which the determination is to be carried
out.

MagIC Net method

Selection of the MagIC Net method with which the determination is to be
carried out.

Comment

Freely definable comment on the determination, that is saved together with
the determination.

Sample ID

Identification of the sample.

Sample position

Position of the sample on the rack of a sample changer. This number is
increased automatically by one when a new line is inserted.

Sample size tiamo

Sample size for tiamo method.

Dilution

ID2 for tiamo method, dilution for MagIC Net method.

Sample type MagIC Net

Selection of the sample type for MagIC Net method. The selection depends
on the MagIC Net method.

Volume MagIC Net

Volume for MagIC Net method.

Status

Display of the status of the sample (see "Status", page 8).
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Functions

[OK]

Apply the sample data entered in the respective line of the sample table. The
same function can also be triggered by pressing the [Enter] key.

[Cancel]

Close the input window. The current sample data will not be applied in the
sample table thereby.

[<]

Apply the sample data entered in the respective line of the sample table and
jump to the preceding line.

[>]

Apply the sample data entered in the respective line of the sample table and
jump to the next line.

2.5.3 Sample table file format
TitrIC sample tables are saved as CSV files.
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3 Database

Definiton

The term Database is used in TitrIC to refer to the program part in which
the determinations saved can be displayed, managed, reprocessed and
where reports can be created.

3.1 Database - Desktop

Program part: Database

Database symbol

Clicking on the database symbol in the vertical bar on the left opens the
program part Database while, at the same time, the database symbol is
shown in color.

Elements

The desktop of the program part Workplace comprises the following ele-
ments:

￭ Menu bar
￭ Toolbar
￭ Filter selection
￭ Determination overview

3.2 Menu bar

3.2.1 Database - Main menus
Program part: Database

The menu bar in the program part Database contains the following main
menu items:

￭ File
Create new sample table, Open and save sample table.

￭ Database
Edit database.

￭ View
Display tiamo or MagIC Net.
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￭ Settings
Edit settings for Tiamo, MagIC Net, TitrIC and the Reprocessing.

￭ Help
Open Help, show program info.

3.2.2 Menu File
Menu item: Database ▶ File

Current report Display the report of the current determination (see Chapter 3.6, page 15).

Database report Display the report of the selected determination (see Chapter 3.6, page 15).

Select all Select all determinations of the database.

Export results Export selected determinations as CSV file (see Chapter 3.7, page 17).

Exit End program

3.2.3 Menu Database
Menu item: Database ▶ Database

Edit filter... Open the Settings Filter dialog for managing and editing the database filters
(see Chapter 3.8, page 17).

Reprocess... Open the Settings reprocessing dialog for the selected determinations (see
Chapter 4.4, page 31).

Delete determina-

tions Delete the selected lines from the determination overview.

Archive Open the dialog Archive database (see Chapter 3.10, page 18).

Settings Open the dialog Settings database (see Chapter 3.11, page 19).

Administrator set-

tings ▶

Start database

editor
Open the Database editor dialog to manage and edit TitrIC databases (see
Chapter 3.12.1, page 21).

Generate data-

base Create new TitrIC database and save it (see Chapter 3.12.2, page 24).

Activate data-

base Activate database (see Chapter 3.12.3, page 24).
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User-defined

result Create user-defined result (see Chapter 3.12.4, page 24).

3.2.4 Menu View
Menu item: Workplace / Database ▶ View

Show tiamo Show tiamo window.

Show MagIC Net Show MagIC Net window.

3.2.5 Menu Settings
Menu item: Workplace / Database ▶ Settings

Settings tiamo Open dialog window with the settings for tiamo (see Chapter 4.1, page 28).

Settings MagIC Net Open dialog window with the settings for MagIC Net (see Chapter 4.2, page
29).

Settings TitrIC Open dialog window with the settings for TitrIC Net (see Chapter 4.3, page
30).

Settings  Reprocess-

ing
Open dialog window with the settings for reprocessing (see Chapter 4.4, page
31).

3.2.6 Menu Help
Menu item: Workplace / Database ▶ Help

Info Display information about the program and the installation.

TitrIC Help Open TitrIC Help.
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3.3 Toolbar

Program part: Database

Some of the functions of the database program part can be accessed directly
via symbols in the toolbar.

Open the Edit filter settings dialog for managing and editing the database
filters (see Chapter 3.8, page 17).

Open the Settings reprocessing dialog for the selected determinations
(see Chapter 4.4, page 31).

Delete the selected lines from the determination overview.

Display the report of the current determination (see Chapter 3.6, page
15).

Display the report of the selected determination (see Chapter 3.6, page
15).

Sort determinations in the overview according to Date ascending or
descending.

3.4 Filter selection

Program part: Database

Select filter and apply to the database. All of the filters defined in TitrIC are
available for use.
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3.5 Determination overview

Program part: Database

The determinations of the database are displayed in tabular form.

Each line corresponds to a determination.

The determination overview can be filtered and sorted.

The databank settings can be used to change which columns are visible in
the determination overview.

3.6 Report

Menu item: Database ▶ File ▶ Current report / Database report

The TitrIC report summarizes the titration and ion chromatography data for
a determination. It contains the following fields:

Printing date

Date on which the report was generated.

General data

The general data is generated for every determination and output in the
report.

Sample ID

Sample ID of the determination.

Date

Date on which the determination was recorded.

Time

Time at which the determination was recorded.

Comment

Comment on the determination.

System comment

Automatically generated comment of the system, which describes whether
the limit value for the ion balance [%] was observed.

Titration data

The database settings can be used to change which titration data is output
in the report.
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IC data

The database settings can be used to change which IC data is output in the
report.

Balances

Titration and IC data is summarized in the balances. These results are always
generated; whether they appear in the report or not can be set in the data-
bank settings.

Note

In order to be able to compare different ions and to generate an ion
balance, all of the concentrations that were determined are converted to
the equivalent value for monovalent ions [mEq/L].

1 mEq/L corresponds to 1 mmol/L of a monovalent ion.

Sum anions [mEq/L]

Sum of the concentrations of all anions.

Sum cations [mEq/L]

Sum of the concentrations of all cations.

Ion balance [mEq/L]

= Total cations [mEq/L]− Total anions [mEq/L].

￭ Positive value
More mEq/L cations than anions were found.

￭ Negative value
More mEq/L anions than cations were found.

Ion balance [%]

= 100 * Ion balance [mEq/L]∕ (Total cations [mEq/L]+ Total anions [mEq/L] ).

Functions

[Print]

Open standard printing dialog, the TitrIC report can be printed out on any
conventional printer.

[<]

Display the report of the previous determination in the database.

[>]

Display the report of the next determination in the database.
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3.7 Export

Menu item: Database ▶ File ▶ Export results

The data is exported in a CSV file.

All of the data fields present in the database are exported.

Each determination corresponds to one line in the CSV file.

Each data field corresponds to one column. The TitrIC settings can be used
to configure whether the title of the field designations are exported into the
CSV file as column headings.

3.8 Settings filter

Menu item: Database ▶ Edit filter...

Filter list

The list of filters that are defined in TitrIC is located on the left-hand side of
the dialog.

Filter properties

The properties of the selected filter are displayed on the right-hand side of
the dialog. The significance of the properties is described in the Edit filter
dialog.

Functions

[New]

Open dialog Edit filter for new filter.

[Edit]

Open dialog Edit filter for the selected filter.

[Delete]

Delete selected filter.

[OK]

Closes the dialog and applies the selected filter to the database.

[Cancel]

Closes the dialog.
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3.9 Edit filter

Menu item: Database ▶ Edit filter... ▶ Settings filter ▶ New / Edit

Name

Entry of a name for the filter.

Field

Selection of a data field for which a condition is to be formulated.

Selection 'Field name'

'Field name'
Filtering is carried out only for the selected field.

Operator

Selection of the comparison operator for the filter criterion.

Selection = | > | < | <>

Value

Entry of the comparative value for the filter criterion.

Input Any text or a numerical value

Functions

[OK]

Save modifications and return to the Settings filter dialog.

[Cancel]

Reject modifications and return to the Settings filter dialog.

3.10 Archive database

Menu item: Database ▶ Archive

Note

A database archive consists of three files (*.log, *.properties, *.script).
An archived database can be restored with the menu items Data-
base ▶ Database ▶ Administrator settings ▶ Activate database.

Archive directory

Directory in which the files of the database archive are stored.
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Open dialog for selecting the directory.

Delete data records after archiving

on | off (Default value: off)

The archived data records are deleted from the database after the archiving
has been completed.

Protocol

Source and target directory and the archived files are listed.

Functions

[OK]

Start archiving.

[Cancel]

Cancel archiving and close dialog.

3.11 Settings database

Menu item: Database ▶ Settings database

The output of the determination data can be edited in the Settings data-
base dialog window. Configurations are set up here as to which data will
be displayed in the Determination overview and in the TitrIC report.

Which determination data is available for use is a property of the TitrIC
database. The General data and the Balances are always present, Titra-
tion data and IC data are database-specific.

General data

The general data is generated for every determination.

Sample ID

Sample ID of the determination.

Date

Date on which the determination was recorded.

Time

Time at which the determination was recorded.

Comment

Comment on the determination.
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Titration data

The titration data of a determination is configured in the database editor.

IC data

The IC data of a determination is configured in the database editor.

Balances

Titration and IC data is summarized in the balances. These results are always
generated.

Note

In order to be able to compare different ions and to generate an ion
balance, all of the concentrations that were determined are converted to
the equivalent value for monovalent ions [mEq/L].

1 mEq/L corresponds to 1 mmol/L of a monovalent ion.

Sum anions [mEq/L]

Sum of the concentrations of all anions.

Sum cations [mEq/L]

Sum of the concentrations of all cations.

Ion balance [mEq/L]

= Total cations [mEq/L]− Total anions [mEq/L].

￭ Positive value
More mEq/L cations than anions were found.

￭ Negative value
More mEq/L anions than cations were found.

Ion balance [%]

= 100 * Ion balance [mEq/L]∕ (Total cations [mEq/L]+ Total anions [mEq/L] ).

Functions

[OK]

Apply settings and close dialog.

[Cancel]

Reject modifications and close dialog.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 3 Database

TitrIC 2.0 ￭￭￭￭￭￭￭￭ 21

3.12 Administrator settings

Note

The administrator settings should be edited only by very experienced
users.

The database is configured in this part, new databases can be generated
and activated.

Data could get lost through incorrect handling!

3.12.1 Database editor

3.12.1.1 Database editor - Desktop

Menu item: Database ▶ Administrator settings ▶ Start database editor

The desktop of the dialog window Database editor comprises the follow-
ing elements:

￭ Menu bar
￭ Toolbar
￭ Result table

3.12.1.2 Menu bar

3.12.1.2.1 Database editor - Main menu

Menu item: Database ▶ Administrator settings ▶ Start database editor

The menu bar in the Database editor program part contains the following
main menu items:

￭ Database
Manage databases.

￭ Result table
Edit result table of the database.

￭ Info
Information about the database editor.

3.12.1.2.2 Menu Database

Menu item: Database editor ▶ Database

New database... Create new empty database scheme.

Open database... Select and open saved database scheme (*.con).
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Save database Save the currently opened database. The database scheme (*.con) is saved and
the associated database file (*.script) is generated and saved.

Save database as... Save the opened database under a different name. The database scheme (*.con)
is saved and the associated database file (*.script) is generated and saved.

Delete database Select and delete saved database scheme (*.con).

Exit Close database editor.

3.12.1.2.3 Menu Result table

Menu item: Database editor ▶ Result table

Insert line Open the Edit results dialog for editing the result and for inserting new lines
ahead of the selected line in the result table (see Chapter 3.12.1.5, page 23).

Edit line Open the dialog Edit result  for the selected line of the sample table (see Chapter
3.12.1.5, page 23).

Delete lines Delete the selected line from the result table.

3.12.1.2.4 Menu Info

Menu item: Database editor ▶ Info

Info Display information about the database editor.

3.12.1.3 Toolbar

Menu item: Database ▶ Administrator settings ▶ Start database editor

Some of the functions of the Database editor dialog window can be
accessed directly via symbols in the toolbar.

Save the currently opened database. The database scheme (*.con) is saved
and the associated database file (*.script) is generated and saved.

Save the opened database under a different name. The database scheme
(*.con) is saved and the associated database file (*.script) is generated and
saved.

Select and delete saved database scheme (*.con).



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 3 Database

TitrIC 2.0 ￭￭￭￭￭￭￭￭ 23

Open the Edit result dialog for editing the result and for inserting new lines
ahead of the selected line in the result table (see Chapter 3.12.1.5, page
23).

Open the dialog Edit result  for the selected line of the sample table (see
Chapter 3.12.1.5, page 23).

Delete the selected line from the result table.

3.12.1.4 Result table

Menu item: Database ▶ Administrator settings ▶ Start database editor

All user-defined results for the current TitrIC database are displayed in tabular
form in the result table of the database editor.

Each line corresponds to one result. For the meaning of the columns, see
the Edit result dialog.

The result table can not be edited or sorted directly. The results are edited
either through the menu Result table or by double-clicking on a line.

3.12.1.5 Edit result

Menu item: Database ▶ Administrator settings ▶ Edit result

Note

The name of the result must be unambiguous in TitrIC!

Name

The result name that is displayed in TitrIC. Is used to label the column in the
determination overview and as a field name in the TitrIC report.

Category

This setting determines from which source TitrIC extracts the result and how
it is displayed in the TitrIC report.

Selection TIT | IC

TIT
The result is extracted from the data of the tiamo determination and is
displayed in the TitrIC report under the titration data.
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IC
The result is extracted from the data of the MagIC Net determination and
is displayed in the TitrIC report under the IC data.

Search key

Character string according to which TitrIC searches in the results of the tiamo
and/or MagIC Net determination in order to extract the desired result.

3.12.2 Generate database
Menu item: Database ▶ Database ▶ Administrator settings ▶ Generate database

Select an existing database scheme (*.con file) and generate a new data-
base from it.

Note

This function can be used to generate databases very quickly that have
identical configurations, e.g. if the current database is full.

3.12.3 Activate database
Menu item: Database ▶ Administrator settings ▶ Activate database

Select an existing database file and make it the active TitrIC database.

Note

The files (*.log, *.properties, *.script) of the database, which is to be
activated, must be in the directory ...\Application Data\Titric\Data-
base.

Note

This action requires TitrIC to be restarted.

TitrIC is closed and the previous database is saved automatically as
Db_Backup#.script.

3.12.4 User-defined result
Menu item: Database ▶ Administrator settings ▶ User-defined result

The dialog Edit result opens. User-defined results can be edited directly
with this menu item, without requiring that the database be edited in the
database editor.
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Note

Only results can edited which were created in the database with the name
User-defined result #.

A user-defined result can no longer be edited directly once it has been
renamed.

5 user-defined results are contained in the database supplied which
can be edited directly.

3.12.5 Data assignment
The results are communicated to TitrIC by tiamo and MagIC Net per CSV
file. The following conditions must be fulfilled in order to ensure that this
functions smoothly:

￭ The tiamo method used must contain a corresponding export command.
The tiamo and MagIC Net method used must contain a corresponding
export command when TitrIC determinations are being reprocessed.

￭ The export template must use the correct settings.
￭ The export files must contain the correct result fields in the correct

sequence.
￭ The result names in tiamo or MagIC Net must match the search keys in

the database.

Note

You will find detailed information concerning the following subjects in
the Online Help of tiamo and MagIC Net:

￭ Method generation
￭ Data export and export templates
￭ Definition of results and naming conventions

3.12.5.1 Export template tiamo

Settings

Target directory

Must match in TitrIC and in the export template of tiamo.

￭ Must match Export file in the Settings tiamo dialog.
￭ Must match Export file tiamo in the Settings reprocessing dialog.

File type

The *.csv (Comma Separated) type must be selected.
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File name

The option Fixed file name (attach data) must be selected.

The name must match in TitrIC and in the export template of tiamo.

￭ Must match Export file in the Settings tiamo dialog.
￭ Must match Export file tiamo in the Settings reprocessing dialog.

Data fields

The following fields must appear at the beginning in this sequence:

￭ Start counter (from Determination ▶ Identification)
￭ ID1.Name (from Sample ▶ Identifications)
￭ ID1.Value (from Sample ▶ Identifications)

Afterwards follow the results which are to be transferred from tiamo to
TitrIC. The sequence of the results is not decisive, nevertheless the fields
RSxx.Name, RSxx.Value and RSxx.Unit must be present in this sequence
for every result.

Result assignment

The following rules apply for assigning the results in the TitrIC database to
the tiamo results:

￭ TitrIC results with the Category TIT are assigned to tiamo results.
￭ The TitrIC result is assigned if its Search key matches the Result

name of the tiamo result.

Note

The following results must always be available in tiamo, they are used for
the calculation of the balances (see Chapter 3.11, page 19):

￭ anions titration
￭ cations titration

3.12.5.2 Export template MagIC Net

Settings

Target directory

Must match in TitrIC and in the export template of MagIC Net.

￭ Must match Export file MagIC Net in the Settings reprocessing
dialog.

File type

The *.csv (Comma Separated) type must be selected.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 3 Database

TitrIC 2.0 ￭￭￭￭￭￭￭￭ 27

File name

The option Fixed file name (attach data) must be selected.

The name must match in TitrIC and in the export template of MagIC Net.

￭ Must match Export file MagIC Net in the Settings reprocessing
dialog.

Data fields

The following fields must appear at the beginning in this sequence:

￭ Start counter (from Determination ▶ Identification)
￭ Info 1 (from Sample ▶ Identifications)
￭ Ident (from Sample ▶ Identifications)

Afterwards follow the results which are to be transferred from MagIC Net
to TitrIC. The sequence of the results is not decisive.

Result assignment

The following rules apply for assigning the results in the TitrIC database to
the MagIC Net results:

￭ TitrIC results with the Category IC are assigned to MagIC Net results.
￭ The TitrIC result is assigned:

– If its Search key matches the Result name of one user-
defined MagIC Net result (RS.'search key').

– If its Search key matches the Component name of the com-
ponent result CONC of MagIC Net (RS.'analysis
name'.'search key.CONC).

Note

The following results must always be available in MagIC Net, they are used
for the calculation of the balances (see Chapter 3.11, page 19):

￭ anions IC
￭ cations IC
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4 Settings

4.1 Settings tiamo

Menu item: Settings ▶ Settings tiamo

Settings

tiamo window

The setting defines how tiamo is displayed.

Selection show | minimize | hide

show
The window is displayed, it is normally accessible.

minimize
The window is minimized in size, it can be opened again with the Win-
dows task bar.

hide
The window is hidden, it is not accessible via Windows.

Export file

File from which the tiamo data is extracted.

Open dialog for selecting the export file.

tiamo workplace

Selection of the tiamo workplace at which the TitrIC determinations are to
be carried out.

Start command MagIC Net

Name of the command in the tiamo method which starts the MagIC Net
method.

Unit sample size

Unit of the sample datum 'sample size' in tiamo.

Functions

[OK]

The settings are stored and the dialog is closed.

[Cancel]

The dialog is closed and modifications are rejected.
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4.2 Settings MagIC Net

Menu item: Settings ▶ Settings MagIC Net

Settings

Shut down IC devices automatically

on | off (Default value: on)

IC devices are shut down automatically after the TitrIC sample table has been
processed.

MagIC Net window

The setting defines how MagIC Net is displayed.

Selection show | minimize | hide

show
The window is displayed, it is normally accessible.

minimize
The window is minimized in size, it can be opened again with the Win-
dows task bar.

hide
The window is hidden, it is not accessible via Windows.

Program directory

Path to the directory in which the file Magicremote.exe is located. The
path is entered automatically when TitrIC is installed.

Open dialog for selecting the directory.

TCP/IP Port

Entry of the TCP/IP port through which TitrIC communicates with
MagIC Net. The port is assigned automatically when TitrIC is installed.

MagIC Net workplace

Selection of the MagIC Net workplace at which the TitrIC determinations
are to be carried out.

Functions

[Connection test]

A check is made as to whether communications with MagIC Net functions
via the TCP/IP port.
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[OK]

The settings are saved and the dialog is closed.

[Cancel]

The dialog is closed and modifications are rejected.

4.3 Settings TitrIC

Menu item: Settings ▶ Settings TitrIC

Export

CSV export

on | off (Default value: off)

Export TitrIC results after each determination.

Column headers in CSV file

on | off (Default value: on)

In addition, the field designations are output as column headings with CSV
export.

Target directory

Directory into which the CSV file is to be exported.

Open dialog for selecting the directory.

File name

Entry of a name for the CSV file.

Report

Print report after determination

on | off (Default value: on)

Export and print TitrIC results after each determination.

Printer

Select the printer.

Selection All printers which are configured in Windows.

Show ion balance in the report

on | off (Default value: on)

Output ion balance in the TitrIC report.
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Limit for ion balance [%]

Entry of the limit value. The value is monitored, the result is output in the
System comment of the TitrIC report.

Backup

Daily database backup

on | off (Default value: on)

A backup is made of the current TitrIC database every day.

Target directory

Directory in which the database backup is to be stored.

Open dialog for selecting the directory.

Backup time

Entry of the time at which the backup is to take place. Format: hh:mm:ss

Functions

[OK]

The settings are saved and the dialog is closed.

[Cancel]

The dialog is closed and modifications are rejected.

4.4 Settings reprocessing

Menu item: Settings ▶ Settings Reprocessing

Settings

Reprocess titration data

on | off (Default value: on)

The tiamo export file is extracted and the TitrIC results are recalculated with
it.

Reprocess IC data

on | off (Default value: on)

The tiamo export file is extracted and the MagIC-Net results are recalculated
with it.
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Export file tiamo

File from which the reprocessed tiamo data is extracted.

Open dialog for selecting the export file.

Export file MagIC Net

File from which the reprocessed MagIC-Net data is extracted.

Open dialog for selecting the export file.

Functions

[OK]

The settings for reprocessing are saved and the dialog is closed.

Note

If the dialog was opened via the menu items Database ▶ File ▶ Reproc-
ess..., then the reprocessing of the selected determinations will be started
simultaneously. The data of the selected determinations in TitrIC will be
overwritten with the reprocessed values.

[Cancel]

The dialog is closed and modifications of the settings for reprocessing are
rejected.
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5 How to proceed?

5.1 Start TitrIC

How to proceed?

Note

￭ MagIC Net and tiamo must be closed before the start of TitrIC.
￭ When starting TitrIC the tiamo server and the MagIC Net server must

be started. This takes place in the background when starting the com-
puter. The time demanded by this operation depends on the config-
uration of the computer.

 

1 Switch on all instruments.

 

2 Start TitrIC.

MagIC Net, tiamo and TitrIC are started.

 

3 If access to MagIC Net and tiamo is password-protected, then the user
must first log on in MagIC Net and then in tiamo. TitrIC itself has no
user restrictions.

5.2 Exit TitrIC

How to proceed?

1 Exit TitrIC with File ▶ Exit.

TitrIC, tiamo and MagIC Net are closed.
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5.3 Reprocess

How to proceed?

Mode of operation

The actual reprocessing takes place outside of TitrIC. The concerned deter-
minations are reprocessed separately in tiamo and MagIC Net, then CSV
exports of the reprocessed determinations are created by each program and
finally these exports are being imported by TitrIC.

In order to be correctly imported by TitrIC, the CSV exports have to be of a
certain data structure. In addition, the file names and exchange directories
of the export files must match between tiamo and TitrIC as well as between
MagIC Net and TitrIC.

Procedure

Note

If several determinations are to be reprocessed with each other, then the
Sample ID within the determinations must be unambiguous.

 

1 Ensure that the tiamo and MagIC Net export templates are cor-
rectly configured for the CSV export of the reprocessed data.

 

2 Reprocess determinations in tiamo and create CSV export according
to the accurate export template.

 

3 Reprocess determinations in MagIC Net and create CSV export
according to the accurate export template.

 

4 Note

tiamo and MagIC Net exports must be available with the reprocessed
data before the reprocessing in TitrIC can be started.

In the Database program part, use the menu item Data-
base ▶ Reprocess... to open the Settings reprocessing dialog.
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5 Define which data is to be reprocessed and specify paths to the export
files of the reprocessed titration or IC data. The reprocessing is started
with [OK].

5.4 Export

How to proceed?

1 Change to the program part Database.

 

2 Select all determinations which are to be exported.

 

3 Open the dialog for saving with the menu items File ▶ Export
results.

 

4 Select target directory, specify file name and save.

5.5 Restoring database

How to proceed?

Note

The files (*.log, *.properties, *.script) of the database, which is to be
activated, must be in the directory ...\Application Data\Titric\Data-
base.

1 Open the dialog for selection of the database in the Database pro-
gram part with the menu items Database ▶ Administrator set-
tings ▶ Activate database.

 

2 Select and activate the desired database file (*.script).

Note

This action requires TitrIC to be restarted.

TitrIC is closed and the previous database is saved automatically as
Db_Backup#.script.
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